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NEW QUESTION 1
Which two statements are true about Production Scheduling? (Choose two.)

A. Schedule options include: Configure Scop
B. Parameters, and View Settings.
C. Releasing a schedule can update Manufacturing Cloud work orders with revised dates, resources, release status, and work definitions.
D. Refreshing a Production Schedule means that the schedule is being recalculated.
E. A resource's constraint mode has two choices: Relaxed and Constrained.
F. If a work order is not fir
G. Production Scheduling may schedule with an alternate resource.

Answer: AE

NEW QUESTION 2
Which calendar is supported in the supply planning process but does not support bucketing by week?

A. Lunisolar
B. Fiscal
C. Roman
D. Gregorian
E. Julian

Answer: E

NEW QUESTION 3
On the plan page layout that you created, you have several graphs showing the status of the plans and the business. You see a concern in an area and you want
to see the data behind it. What navigation should you use to see this data?

A. You cannot see it from the plan landing page, and you will need to search for the data.
B. On the table in question, go to View > Show table.
C. You cannot see it on the plan outputs, and you will need to create a new table with the information.
D. Go to Actions > View Data on the graph in question.
E. You cannot see it on the plan outputs, so you need to go into Planning Analytics and re- search the data.

Answer: A

NEW QUESTION 4
A planner needs to adjust the schedule for a particular planned order.

A. Open the Supplies and Demands table, select the row of the required planned order, and edit its firm date.
B. Open the Supplies and Demands table, select the row of the required planned order, launch View Calendar Details from the actions menu, and drag the
planned order to the new date.
C. Open the Supplies and Demands table, select the row of the required planned order, drill to the Build Plan, and edit the firm date.
D. Open the Supplies and Demands table, select the row of the required planned order, and edit its suggested due date.

Answer: CD

NEW QUESTION 5
Which three statements are true regarding exceptions? (Choose three.)

A. The conditions under which exceptions are generated can be modified.
B. You can act on an exception by selecting it and clicking 'Resolve exception'. A list of ways to resolve will be generated.
C. The calculation logic for exceptions can be modified.
D. You can drill down into Supplies and Demand from an exception line.
E. You can export exception tables to Excel.
F. You can create custom exceptions.

Answer: ACE

NEW QUESTION 6
Which feature is NOT available for Sales and Operations Planning plans?

A. View Segmentation Summary
B. Configure Exceptions
C. Collect Planning Data
D. Load Planning Data from Files

Answer: B

NEW QUESTION 7
A global company is subject to differing regulations regarding hazardous materials in a product. Version 1 of the product can be sold in North America and Europe.
Version 2 of the product can only be sold in Europe.
Which sequence of setups could help a planner ensure that supply is available in a timely fashion per these constraints?

A. Create an attribute-based netting rule using region and version; map the rule to collectible attributes; associate the rule to a supply plan; run the plan.
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B. Define region and version as planning attributes; map them to collectible attributes; create an attribute-based netting rule using region and version; associate
the rule to a supply plan; run the plan.
C. Define region and version as planning attributes; create an attribute-based netting rule using region and version; associate the rule to a supply plan; run the
plan.
D. Define segment groups based on region and version; execute segmentation; map the segmentation results to an attribute-based netting rule; associate the rule
to a supply plan; run the plan.

Answer: D

NEW QUESTION 8
Which KPIs are available to measure forecasting accuracy and specify how these measures aggregated from item-organization level to higher levels.

A. MAPE, MAD, and Bias are used to measure forecast accurac
B. MAD and Bias are aggregated using su
C. MAPE is aggregated using weighted average.
D. MAPE, MAD, and Bias are used to measure forecast accurac
E. MAPE and Bias are aggregated using weighted averag
F. MAD is aggregated using sum.
G. MAPE, MFE, and Bias are used to measure forecast accurac
H. MAPE and Bias are aggregated using weighted averag
I. MFE is aggregated using sum.
J. MAPE, MFE, and Bias are used to measure forecast accurac
K. MAPE and MFE are aggregated using weighted averag
L. Bias is aggregated using sum.

Answer: A

NEW QUESTION 9
Another planner has previously created a supply plan, but you now need to make some changes so that you can do some 'what-if' analysis. How can you go about
duplicating this plan?

A. You cannot duplicate plan
B. You must create a completely new supply plan.
C. Manage Plans > Search and select supply plan > Actions > Duplicate.
D. Run process "Duplicate supply plans" with existing plan as parameter.
E. Manage Plans > Search and select supply plan > Actions > Edit Plan Options > Select Copy.
F. You cannot duplicate a plan that is not owned by you.

Answer: B

NEW QUESTION 10
Which attribute or attributes can you maintain via the Maintain Supply Network Model task?

A. For Carriers: Enabled
B. For Customer
C. Suppliers, and Organizations: Time Zone
D. For Organizations: Supply Past Du
E. Customer, and ABC Assignment Group
F. For Interlocation Shipping Networks: Carrie
G. Mode of Transport, and Service Level

Answer: B

NEW QUESTION 10
Your current shipments forecast for Jan 2018 is 1000 and the demand planner determines that the forecast should be 1500. Describe how the demand planner
can override shipments forecast. Also, what happens to the final shipments forecast measure when the demand plan is run again and the shipments forecast value
changes to 1250?

A. Open a table with the Adjusted Shipments Forecast measure and enter 1500. The Final Shipments Forecast measure will change to 1500 and the value will
persist during subsequent demand plan runs.
B. Open a table with the Shipments Forecast measure and override it to 1500. The Final Shipments Forecast measure will change to 1500 and the value will
persist during subsequent demand plan runs.
C. Open a table with the Shipments Forecast measure and override it to 1500. The Final Shipments Forecast measure will change to 1500. During the subsequent
demand planrun, the Final Shipments Forecast value will change to 1250.
D. Open a table with the Adjusted Shipments Forecast measure and enter 1500. The Final Shipments Forecast measure will change to 1500. During the
subsequent demand plan run, the Final Shipments Forecast value will change to 1250.

Answer: A

NEW QUESTION 14
You've decided to opt into the Customer Demand Collaboration feature. Which three statements describe what that enables?

A. A customer can use B2B messaging to share their expected needs and historical consumption for the products you sell them.
B. The information they share with you is informational and only available to you in the portal.
C. A customer can log in to a portal and manually enter their expected needs for the products you sell them.
D. You can post to the portal your statistical forecast for the products you sell them so they can see your forecast for them.

Answer: ACD
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NEW QUESTION 16
As part of the agreement with one of our suppliers, you are supposed to order product by the 100s. But if the required supply is only 149, how many should be
planned to purchase, and which item attribute will cause this to happen?

A. Planned Order for 200. Maximum Order Quantity enabled
B. Planned Order for 100. with Minimum Order Quantity enabled
C. Planned Order for 150, with Rounding enabled
D. Planned Order for 200. with Fixed Lot Size Multiplier enabled
E. Planned Order for 149, with Fixed Order Quantity enabled

Answer: D

NEW QUESTION 19
In order for Supply and Demand Plans to run successfully, which three Configure Planning Analytic tasks must be completed? (Choose three.)

A. Set up Levels and Attributes
B. Set up Measure Catalogs
C. Run the Configure Dimension Catalog process
D. Set up Default Catalogs
E. Set up Dimension Catalogs
F. Set up Hierarchy Attributes

Answer: ABE

NEW QUESTION 22
Which release recommendation parameter can you utilize to govern the behavior of the auto-release process?

A. Release Only by User
B. Auto-Release Interval in Days
C. Auto-Release Planned Order Time Fence
D. Quick Release Time Fence
E. Compression Days Tolerance for Automatic Release

Answer: D

NEW QUESTION 26
When running the Publish Order Forecast scheduled process, what is the minimum set of parameters needed to publish additional measures such as requisition
and purchase order data?

A. Publish order details
B. Include requisitions in the order forecast, "Include purchase orders in the order forecast", and "Publish order details"
C. Include purchase orders in the order forecast
D. Include requisitions in the order forecast, "Include purchase orders in the order forecast", and "Publish purchasing details"

Answer: B

NEW QUESTION 28
Your client has high-priority customers with frequent, small volume orders.
Which two steps should a backlog planner consider if a backlog run does not produce the desired results? (Choose two.)

A. Edit the "Enforce Current Commit" or "Pull-in Enabled' demand attributes.
B. Activate more intricate Demand Priority rules.
C. Isolate the problematic customer in its own Backlog Planning run.
D. Consider simulation.
E. Edit the "Pull-in Disabled" demand attribute.

Answer: AD

NEW QUESTION 30
Your Procurement Department is getting ready to set up Approved Supplier Lists that will be needed for Supply Planning. They ask you for what you need on the
ASLs for planning usage. Which three options are key for planning? (Choose three.)

A. Make sure to include Maximum Order Quantities.
B. Make sure to include Minimum Order Quantities.
C. Make sure to include Fixed Lot Multipliers.
D. Make sure to include Fixed Order Quantities.
E. Make sure they are at a Global level.
F. Make sure all Local level ASLs include an Organization.

Answer: BCE

NEW QUESTION 32
Which statement fully describes the contents and purpose of the Product Lifecycle Management (PLM) page layout?

A. The PLM layout has one table to define and manage discontinuation dates, and another table for entering forecast percent changes.
B. The PLM layout has one table to define and manage launch and discontinuation dates, and another for entering forecast adjustments.
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C. The PLM layout has two tables: one to define and manage launch dates for new products, and another for entering forecast adjustments.
D. The PLM layout has a single table to define and manage launch dates, and also enter any forecast adjustments.

Answer: B

NEW QUESTION 34
You want to be able to filter your data by the planner code attribute on the item. Where can you go to do this?

A. Configure Planning Analytics > Levels and Attributes tab
B. The process "Add Levels and Attributes" must be run to associate new attributes.
C. The process "Associate Measure Catalog Attributes" must be run to associate new attributes.
D. Enable planner code on Planning Analytics page.
E. Configure Planning Analytics > Measure Catalog

Answer: D

NEW QUESTION 35
Segmentation was last run many months ago and the replenishment planner is concerned about losing track of items whose policies get changed due to the
upcoming resegmentation. There are also a lot of manually assigned segments that must be preserved. Which two approaches for Execute Segmentation should
you use in this planner?

A. Save the last segmentation result should be selected.
B. No other setting is needed.
C. Auto-approve segmentation changes should not be selected.
D. Retain segment overrides should be selected.

Answer: AD

NEW QUESTION 37
You analyzed your customer's shipment history data at item and organization level. You found that the customer has many new products with limited history.
Does Planning Central support forecasting products with limited history, and what is this process called?

A. No, Planning Central does not support the Croston Method for Sparse Demand forecasting method.
B. Yes, Planning Central supports the Regression for Sparse Demand forecasting method, typically used for new products.
C. Yes, Planning Central supports the Holt Exponential Smoothing forecasting method used for newly introduced products.
D. No, Planning Central does not support the Regression for Sparse Demand forecasting method.
E. No, Planning Central does not support the Holt Exponential Smoothing forecasting method.

Answer: C

NEW QUESTION 41
Which three steps are required so that a supply plan can use different service-level percentages for different groupings of items when calculating safety stock?

A. Create a supply planning policy assignment set.
B. Create segment groups.
C. Assign the percentage on the Safety Stock tab of plan options.
D. Execute segmentation.
E. Create a safety stock policy assignment set.

Answer: ABD

NEW QUESTION 46
Which option outlines changes you can make a simulation plan when evaluating demand and supply?

A. Add demands, cancel demands, reschedule demands, add new planned orders, reschedule supplies
B. Change item specification values, change item lead times, create mass changes for items
C. Change item specification values, change item lead times, create mass changes for items all at once, change item-organization specification values
D. Add demands, cancel demands, reschedule demands, and supply, cancel supply, reschedule supplies
E. Change item specification values, change item lead times, change item-organization specification values

Answer: D

NEW QUESTION 47
Which three statements are true regarding Managing Units of Measure? (Choose three.)

A. A unit of measure conversion is a mathematical relationship between two different units of measure.
B. You must define a unit of measure class with a base unit of measure.
C. Non-standard, intraclass conversion rates can't be item specific.
D. A unit of measure standard conversion specifies the conversion factor by which the unit of measure is equivalent to the unit of measure class.
E. If you want to transact items in units of measure that belong to classes other than their primary UOM class, you must also define conversions between the base
units of measure of the different UOM classes.

Answer: ABE

NEW QUESTION 52
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Which statement is correct regarding S&OP plan options?

A. Calculating Safety Stock can optionally be included.
B. Forecasting profile's input demand measure can only be set to 'consensus forecast' or 'approved consensus forecast'.
C. Supply Planning Mode 'aggregated' can be turned off.
D. Lead time compression can optionally be included as a legitimate plan constraint.

Answer: D

NEW QUESTION 56
Which option outlines changes you can make to a simulation plan when evaluating demand and supply?

A. Change item specification values, change item lead times, create mass changes for items
B. Add demands, cancel demands, reschedule demands, add supply, cancel supply, reschedule supplies
C. Change item specification values, change item lead times, change item-organization specification values
D. Add demands, cancel demands, reschedule demands, add new planned orders, reschedule supplies
E. Change item specification values, change item lead times, create mass changes for items all at once, change item-organization specification values

Answer: B

NEW QUESTION 57
Which two statements are true when using Measure catalogs? (Choose two.)

A. The predefined measure catalog is not the system default.
B. The measure catalog has a collection of measures that you can enable for use in a single plan in the Planning Central work area.
C. You can restrict access to Measure Catalogs using Administer Data Security.
D. You can add or remove measures from a measure catalog.
E. Measure catalogs are defined in the system to improve the performance of the plan.
F. You navigate to Configure Measure Catalogs to edit the Catalog.

Answer: BD

NEW QUESTION 59
What is one method of associating a Safety Stock Quantity value to an item?

A. Upload the value using File Based Data Import (FBDI)
B. Enter your value in the Safety Stock Quantity column in the Items page.
C. Run the Safety Stock Quantity Update Process.
D. Enter your value in the Safety Stock Quantity Override column in the Items page.

Answer: B

NEW QUESTION 61
Your buyers are very attentive in maintaining the approved supplier lists as needed. One of
your planners regularly uses the portal to communicate with some of their key suppliers and has noticed that the publication process is taking a lot longer to
complete because the business has grown. The planner is also complaining that the collaboration candidates' list is cluttered with items that are not yet required.
Which two steps should you take to address the planner's complaint?

A. Activate a Supply Chain Collaboration setting to ignore zero forecast combinations.
B. Activate the "Ignore for Supplier Collaboration" item attribute.
C. Activate a profile option called "Publish Order Forecast Using Sourcing Rules".
D. Disable the decomposition and generate candidates' parameters in the Publish Order Forecast scheduled process.

Answer: CD

NEW QUESTION 65
In which situation would Bills of Distribution be more effective than Sourcing Rules?

A. When Organization A, Organization B, and Organization C make their own products
B. When Organization A buys from a Supplier; Organization B transfers from Organization A, and Organization C transfers from Organization B
C. When all organizations transfer 50% of the material from Organization B, and 50% from Organization C
D. When all organizations are buying from a single outside supplier
E. When Organization A, Organization B, and Organization C transfer from Organization C

Answer: B

NEW QUESTION 66
You just ran a Data Collection and want to confirm that certain data was successfully collected. Identify three collected data sets that can be viewed on the
Maintain Supply Network Model Page. (Choose three.)

A. Safety Stock and Subinventories
B. Supplier Site and Service LevelC Calendar and Master Organization
C. Customer Location and Carriers
D. Customers and Customer Sites

Answer: BCD
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NEW QUESTION 70
Your company needs to implement project-driven supply planning, along with demand and supply netting based on the country of origin. Which setup task is
needed for this?

A. Manage Demand and Supply Netting Rules task
B. Manage Attribute-Based Netting Rules task
C. Manage Project Netting Rules task
D. Manage Attribute and Project Netting Rules task

Answer: D

NEW QUESTION 73
You want to check how many items have excess inventory. Which three choices will get you there? (Choose three.)

A. Open Table, Graph, or Tile Set > Table: Item Exceptions Summary > Filter by Items with Excess Inventory
B. Manage Plans > Edit Plan Options > Select Supply tab > Navigate to Item area > Filter by Items with Excess Inventory
C. Open Table, Graph, or Tile Set > Table: Exceptions > Expand Supply Planning Exceptions > Select Items with Excess Inventory
D. Open Table, Graph, or Tile Set > Table: Items with Exceptions > Filter by Items with Excess Inventory
E. Open Table, Graph, Tile Set > Table: Items > Select any Item > Drill to: Item Exceptions> Expand Supply Planning Exceptions > Select Items with Excess
Inventory > Refresh the search results

Answer: BCE

NEW QUESTION 76
Which statement is NOT true about item attributes?

A. The "forecast control" item attribute must be assigned if configure-to-order (CTO) items are being planned.
B. Many item attributes can be overridden as part of a simulation set that gets applied to a plan.
C. Some item attributes can be overridden directly in the Items table for simulation purposes.
D. Supply plans ignore items with the "planning method" attribute set to MPP.

Answer: D

NEW QUESTION 79
Your customer has seasonal demand and wants to generate forecast for next six months. You ran a demand plan for first time using six months of shipments
history but the forecast accuracy was low.
Identify two statements that are true in this scenario. (Choose two.)

A. Running a demand plan with both shipments and booking forecast profile is required to forecast seasonal demand.
B. Running a demand plan with less than one year of history will impact seasonal analysis.
C. Running a demand plan with both shipments and seasonal shipments forecast profile is required to forecast seasonal demand.
D. Running a demand plan with six months of booking history instead of six months of shipment history is required for seasonal demand.
E. Running a demand plan with 18 to 36 months of shipments history is recommended.

Answer: DE

NEW QUESTION 80
Which three options represent predefined hierarchies in Planning Central? (Choose three.)

A. Business unit
B. Demand Class
C. Resource
D. Exception Type
E. Pricing
F. Sales Channel

Answer: ABC

NEW QUESTION 83
......
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